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Scripts > SpeedTree FBX for Maya
This Maya plug-in extends the standard FBX importer for use with SpeedTree-generated models.

This script has been deprecated. We have a new, streamlined process outlined here. This
script and its documentation will be included until the process of migrating all of the

functionality contained within is complete.

Maya SpeedTree FBX Plug-In Location

The Maya SpeedTree FBX plug-in is located in a subdirectory of the SpeedTree Modeler installation
folder:
“[SpeedTree Modeler Install Dir]/Scripts/Maya/SpeedTreeFBX.py”

../start.pdf
../speedtree_fbx_for_maya.pdf
../speedtree_fbx_for_maya.pdf


Overview
Image rendered in Maya using mental ray. Shaders from the SpeedTree 'FBX' plug-in. The
SpeedTree 'FBX' for Maya plug-in extends the standard 'FBX' importer by providing several new
features that specifically help SpeedTree models work in a professional Maya rendering pipeline. It's
main functions are to build and maintain shaders in an automated, clean way.

The plug-in implements a custom SpeedTree 'FBX' node between the tree geometry and the shader.
The SpeedTree 'FBX' node, similar to a shader – consider it a pre-shader, helps compute all of the
values that are assigned to the final shader. This way, attributes can be kept in a range that matches
the values in the SpeedTree Modeler, making it easy to harbor predictable shading results.

Using the SpeedTree 'FBX' pre-shader lets you maintain a matching look between renderers without
any hassle Whether you are using the Maya Software, Maya Hardware, Maya Hardware 2, or mental
ray renderer, the pre-shader will automatically choose the most appropriate shading node (be it a
“phong” or a “mia_material” for mental ray) and utility nodes in between the pre-shader and the
shader. The SpeedTree 'FBX' pre-shader is “monolithic” in that it will handle all types of tree
materials, whether they require translucency, specularity, transparency, gamma correction,
displacement, or other effect.



Features Include:
SpeedTree-compliant shaders are created automatically, keeping in sync with all four of Maya's●

preloaded renderers.

A custom SpeedTree FBX node between the tree and the shader maintains the shading network●

automatically.

Support for skeletal and point cache animation together.●

Support for SpeedTree branch intersection blending.●

Support for normal-mapping in all four native renderers.●

Support for advanced rendering features such as translucency, gamma compensation,●

displacement, and vertex color rendering.

SpeedTree FBX files can be imported through the native mesh importer ( “File→Import…” ) or●

through MEL/Python calls.

SpeedTree shading networks can be “baked”, removing the SpeedTree FBX component and●

leaving behind the values that were set at the time of the bake.

Supported Versions of Maya:

Maya 2009, Maya 2010, Maya 2011, and Maya 2012 are supported (requires a version of Maya that
supports the Python API).

Supported Renderers:

The Maya Software, Mental Ray, Maya Hardware, and Maya Hardware 2 renderers are supported.
The hardware renderers are only supported by Maya 2012.

There are occasional issues about using Viewport 2.0. SpeedTree FBX is more stable with
Viewport 2.0 if “Maya Hardware 2” is the selected process type.

Installation

Installing The Plug-In

To install the plug-in, open up the Maya Plug-In Manager (menu item “
Window→Settings/Preferences→Plug-In Manager”). Select the “Browse” button along the
bottom and select this file – “[SpeedTree Modeler Install Dir]/Scripts/Maya/SpeedTreeFBX.py”.

All associated files needed for the plug-in to function are added to Maya's search paths upon loading.
The necessary associated files are listed below:

SpeedTreeFBX.py



icons/out_SpeedTreeFbx.xpm
icons/render_SpeedTreeFbx.xpm
icons/SpeedTreeAbout.bmp
icons/SpeedTreeAsset.xpm
icons/SpeedTreeFbx.png

templates/AESpeedTreeFbxTemplate.mel
templates/SpeedTreeFbxContainer.template
templates/SpeedTreeFbxTranslatorOptions.mel

SpeedTree SWA Importer Plug-In

If this is your first time loading the plug-in, the SpeedTree SWA Importer plug-in will be
automatically loaded as well. This is to avoid double manual loading of each.

Automatic Loading

It is advisable to set the SpeedTree FBX plug-in to auto-load with Maya. Enable the “Auto-Load”
option in the Plug-In Manager for this behavior.

In order for the plug-in to be listed in the Plug-In Manager the next time Maya loads, the
SpeedTree FBX plug-in location is appended to the “Maya.env” file located in the
documents folder for the installed version of Maya. If the plug-in fails to locate

“Maya.env”, the plug-in can either be manually moved (with all associated files) to a
location that is scanned by Maya on load, or the plug-in location can be added manually to
your “Maya.env” file. Note that sometimes, the line will only register in “Maya.env” if it is

listed first.

Importing Tree Models

Using the Plug-In To Import FBX Files

Once the plug-in has been loaded, import a SpeedTree FBX model using the menu item “
File→Import…”, as you would with a standard FBX file. In the “Files of type” selector, choose
“SpeedTree FBX”. Importing preferences should be visible on the right hand panel under “File-type
specific options” (see below).

Importing With Commands

Additionally, SpeedTree 'FBX' files can be imported using the MEL command “ImportSpeedTreeFbx
”, or the python command “maya.cmds.importSpeedTreeFbx()” (note: for python, maya.cmds must
first be imported into the main module).



NOTICE: Maya 2011 Only - Using the “Import…” menu item does not work in Maya 2011.
As such, the option has been disabled in that version. Instead, use the following MEL
command to get your SpeedTree 'FBX' models into the scene: ImportSpeedTreeFbx;

Import Options

While importing a SpeedTree FBX model, several options are presented so that the resulting shaders
are processed as desired (for the correct renderer with the correct render settings). This panel is
visible when a SpeedTree model is being imported through the “File→Import…” menu item, under
the option group “File-type specific options”.

Note that enabling these options here will not “force” them on, but rather will allow each option to
become enabled as deemed necessary by the plug-in on a shader by shader basis.

Shader Settings:
These options control the overall structure of the resulting shading networks. For more info on the
specific options, see the Shader Actions section below.

“Bake Resulting Shaders” will remove the SpeedTree 'FBX' nodes after processing the shader. Use
this option only when the scene must be opened on a computer that does not have the SpeedTree
'FBX' plug-in installed. Shaders must be manually manipulated afterwards. Keep in mind that
shaders can also be baked after this step.

Surface Options:
The options in this group control basic surface attributes of the shader, including whether
translucency should be enabled when applicable.



For more information on these specific options, see the following sections: Surface Attributes and
Translucency.

Advanced Surface Options:
These options are generally only applicable to specific renderers. Options that do not apply to the
current or selected renderer type will appear disabled. For more info see Advanced Surface
Attributes.

Reset To Defaults:
This button will reset all options to the state they were in when the plug-in was first loaded
(including “auto-update shaders” and “sync gamma”, which are not visible on this panel).

Shader Actions Group
The “Shader Actions” group houses various utilities for tailoring your SpeedTree FBX experience.

Current Shader

This label displays the currently linked shader node, and the method that was used to process this
shader (in parentheses). By pressing the “output connection” button on the right, the linked shader
is selected in the Attribute Editor.

Process For

Selects the desired “process type” that is used when the shader is processed the next time.
“Processing the shader” means to let the plug-in choose the most appropriate shading model and
utility nodes given the target renderer.

A shader can be reprocessed by pressing the “Update Shader For Renderer” button. Or, if the
“Current Renderer” option is chosen, the shader can be set to reprocess every time the renderer
changes.

Using the “Generic” option results in a phong shader that works with more than one renderers, but



lacks some of the more advanced features. All other options are renderer specific.

Auto Update Shaders When Renderer Changes
If using the “Current Renderer” process type, enabling this option will automatically update the
linked shader whenever the renderer changes.

Update Shader For Renderer
Updates the linked shader to match the chosen process type.

Bake SpeedTree Shader Settings

This action will transfer or “bake” the attributes from the SpeedTree FBX node into then connected
outgoing plugs, removing the SpeedTree FBX node entirely from the shading network. If an asset
container is in use, the attribute values will be transferred to the container interface.

More Info: Baking Shaders

Create "Asset" Container

When enabled, all utility and texture nodes used to create the final shading are collected into an
“asset” container node. This reduces the clutter and complexity of the scene for non-programming
TDs.

More info: Using Asset Containers

Texture Maps Group

 The attributes in the “Texture Maps”
group are used to assign texture filenames to the shader. These textures filenames will be plugged



into the appropriate file nodes. To change a filename assignment, either type a different name into
the edit box or browse for a different image file using the folder icon to the right of each slot.

Alpha Override Maps

Slots signified with an asterisk (*) at the end of the label are used as “alpha override maps”.
Whether these maps were generated and assigned to the 'FBX' model is controlled via the 'FBX'
Exporter within the SpeedTree Modeler.

Alpha override maps can be used to create more complex shaders (for instance, the opacity map
does not have to match the diffuse map). Certain renderers expect all maps to be independent files
as well. In the SpeedTree Modeler, these maps are stored in the alpha channel of other maps,
reducing the number of maps that need to be looked up. This is an optimization for real-time tree
models.

Disabled Slots

Any map slots that are not used in the shading calculation are disabled. You cannot use these map
slots after the shader has been generated. This is because each shading network is customized to
only include conversions for slots that were present in the 'FBX' file at the time of creation. Most
shaders do not need every available slot, so do not be concerned if many of these slots are disabled
for any particular shading network.

Surface Attributes Group

 The attributes in this group govern the
appearance of the shader surface, including color, transparency, and specular properties.

Use Ambient
Some shader types support a separate ambient color per shader. The effect can be toggled off for
those shader types with this checkbox.

Ambient Color
When “Use Ambient” is enabled, the color of ambient (unlit) shading.

Diffuse Color



The color blended with the diffuse (color) texture map.

Diffuse Scalar
Scales the intensity of the final diffuse component (color + texture map).

Specular Color
The color blended with the specular texture map (for direct highlights).

Shininess
The coefficient of specular reflectivity, also called “glossiness”.

Alpha Scalar
Scales the “opaque point” of shaders that include transparency. This options is disabled if there is
not a separate opacity texture.

Backface Cull
Hides the backs of faces from the renderer (and in the viewport if possible).

Translucency Group

The attributes in this group govern the usage and appearance of light transmitting through the
geometric surface. This effect is called “translucency”.

Enable Translucency
Enables light to transmit through the surface, illuminating the surface when viewed from behind.

Translucency Color
The color blended with the translucency texture. Not available for all renderers (phong shaders do
not support RGB translucency).



 Translucency Scalar
Scales the intensity of the transmitted light.

View Dependency
The amount that the camera must look directly towards the light source for the effect to be
noticeable.

Shadow Offset
Decreases the visibility of shadows in the translucency effect.

Image: (left) translucency on, (right) translucency off

Advanced Surface Attributes Group
The attributes in this group govern the usage and appearance of light transmitting through the
geometric surface. This effect is called “translucency”.



Branch Intersection Blending

'Branch Intersection Blending' is a technique that blends the textures between branches to create a
seamless intersection. 'Intersection blending' must first be enabled in the SpeedTree Modeler 'FBX'
export settings.

Enable Intersection Blending
When applicable, this toggles the “texture blending” technique used between individual branches.

Blend Weight
A scalar for the “weight” of blended textures vs. base textures in the blend region.

Branch intersection blending vs. no blending.

Displacement

In Maya, displacement is handled independently from the surface shading in a “displacement
shader”. Enabling 'displacement' on the SpeedTree 'FBX' panel will automatically build a matching
displacement shading network and assign it to the shared shading group. The displacement source
must be either a dedicated height map or found in the alpha channel of the normal map.

Enable Displacement
When supported, toggles the creation of a synced displacement shader.

Displacement Scalar
Scales the extrusion distance of the displacement effect.



Displacement Offset
A bias for the direction of extrusion. When set to zero, all extrusion will occur outward. An offset of
-1 will only extrude inward. At -0.5, height values below 0.5 will extrude inward and height values
above 0.5 will extrude outward.

The 'displacement offset' takes into account the displacement scale automatically (e.g. a
displacement scale of zero results in a displacement offset of zero, too).

Displacement Filter
Amount to filter (blur) the displacement source image. Higher values will produce smoother, but less
accurate results.



Render Vertex Colors

When using mental ray or other supporting renderer, this blends geometric vertex colors with the
diffuse component. Vertex colors may include ambient occlusion or additional diffuse color, as
selected in the SpeedTree Modeler 'FBX' export settings.

(left) ambient occlusion and leaf color from vertex colors, (right) no vertex coloring.
Maya 2009 Only - There was a bug in the initial release of Maya 2009 where vertex colors

always rendered black. Upgrade to Service Pack 1, where the problem has been fixed.
Download here.



Gamma Correction

In most cases, if the scene gamma is set to 2.2, the textures and colors need to be corrected to have
a gamma of 0.4545 (the reciprocal) so that they appear to be tone mapped correctly in the final
render. When “Gamma Correct” is enabled on the SpeedTree FBX panel, this can be synced
automatically, or specified manually. In either case, all texture file and color nodes are compensated
for.

Gamma Correct
When enabled, diffuse colors and textures are corrected to work with the scene gamma.

Sync With Scene
When enabled, diffuse color and texture gamma compensation is synced against the scene gamma
correction. The scene gamma is predicted based on the renderer and scene settings.

Synced Against
Scene gamma attribute synced against. Press the “outgoing connection” button to the right of the
label to select the node used to sync against in the attribute editor. The scene gamma is predicted
based on the renderer and scene settings.

Adjust Against Gamma Of
Gamma to adjust against. This field becomes disabled and displays the scene gamma value when
“Sync with scene” is enabled. Otherwise, this value can be set manually.

Apply To All SpeedTreeFBX Nodes
When pressed, the gamma settings from the current SpeedTreeFBX node will be applied to all other
SpeedTreeFBX nodes in the scene. This is a convenient way to sync all of the gamma correction
without syncing to an actual node.

The actual gamma compensation applied to utility nodes is usually the reciprocal of (1
over) this value, not actually this value.

Using "Asset" Containers



What Are "Assets" In Maya

In Maya, complex node organizations can be collected into a parent “container” node for simplicity
of use. The nodes contained inside are hidden from the connection graphs and outliner. Technical
artists can create containers that can be reused for many assets, providing a shared user interface,
and preventing too much tinkering of the contents within.

How To Enable A SpeedTree Container

The type of container we provide is a shading network container. The SpeedTree FBX plug-in lets
you toggle the creation of shading network containers on a per shader basis. To create an asset
container, press the “Create Asset Container” checkbox in the Shader Actions group of the
SpeedTree FBX node.

Optionally, containers can be made for all new shaders via a setting on the SpeedTree FBX import
dialog.

(left) SpeedTree shading network with utility nodes collected into an asset container (the
SpeedTree logo node). (right) the same network expanded.

Baking Shaders Into Asset Containers

When using the asset containers option, the results of “baking” the shader are more user friendly.
Most of the settings on the SpeedTree FBX node are transferred directly to the container node's
“Published Attributes” group. This makes it easy to track down the settings from the SpeedTree FBX
node. See the next section for more info on baking shaders.

Baking Shaders



“Baking” is the process of transferring the attributes from the SpeedTree FBX node to its connected
outgoing plugs, removing the SpeedTree FBX node entirely from the shading network.

The benefit of baking shaders is that the SpeedTree FBX plug-in can be removed, if necessary. For
instance, the scene may need to be opened on another machine that does not have the plug-in
installed. Remember though – once a SpeedTree shader has been baked, the process cannot be
reversed, so it is ideal to wait until you have finalized any renderer specific assignments before
baking.

How To Bake A SpeedTree Shader

To bake a shader, press the “Bake SpeedTree Shader Settings” button in the 'Shader Actions' group
on the SpeedTree FBX node.

Baking On Import
Optionally, all new SpeedTree shaders can be baked during the import process. No new SpeedTree
FBX nodes will be available to edit after the import. All settings will immediately be transferred to
their outgoing connections, or to an asset container if that option is selected too.

Baking Settings Into An Asset Container

If an asset container is in use, the attribute values will be transferred to the container interface
instead of directly to each utility node, if the node itself is inside the asset container (see: image to
the right). Note that not all of SpeedTree's attributes are transferred to the asset container interface
– some are connected straight into the shader itself. The container's published attributes are



organized using a container template to mimic the look and feel of the SpeedTree FBX node,
including appropriate attribute bindings.

(Image on right) SpeedTree settings published to a container.

Usage Tips

When Using The SpeedTree FBX Plug-In

Please read the following suggestions for best usage of the SpeedTree FBX plug-in:

Update your FBX importer (especially for older versions of Maya). The latest version can be●

downloaded following the link below:
Autodesk FBX Downloads Archive -❍

http://usa.autodesk.com/adsk/servlet/pc/item?siteID=123112&id=10775920

Use the “Current Renderer” process type along with “Auto-Update shaders…” to ensure that●

your trees always render right when the renderer is changed.

Use the “Create asset container” option unless it is vital to edit the utility nodes that feed into●

the final shader.

Turn off displacement if it is not necessary for any given material.●

If using gamma correction, try the “Sync with scene” option to ensure that gamma correction is●

always correctly compensated for.

Enable “Include branch blending”.●

Enable “Transmission to emissive”. This will carry the transmission color over to Maya.●

Enable “Separate alpha textures”. This will create separate image files for opacity, displacement,●

and transmission.

If exporting “camera-facing” leaves, first position the camera in the 'Tree Window' to the correct●

place. The leaves will face only the position of the camera at the time of export.

Avoid:

Avoid “baking” shaders until the very last moment, since the process is not reversible.●

Avoid using Viewport 2.0 along with the “Maya Hardware” process type. Use “Maya Hardware 2”●

instead.

When Using Mental Ray:

If your leaf silhouettes render blocky,increase the the “Max Trace Depth” value to at least 5 or 6●

here: Mental Ray Render Settings→Quality→Raytracing→Max Trace Depth.

If your leaf silhouettes render too transparent, increase the “Alpha Scalar” value on each leaf●

shader's SpeedTree FBX node.

http://usa.autodesk.com/adsk/servlet/pc/item?siteID=123112&id=10775920


If using exposure control and/or Mental Ray Sun & Sky, enable “Gamma Correction” on all●

SpeedTree FBX nodes.

Transparent textures will not display opacity in the viewport. This is because there are utility●

nodes hooked directly into the shader's color slots. This is also true in all shader types where
gamma correction is being used.

Exporting FBX Files

When exporting FBX files from the SpeedTree Modeler, use these settings for the best
results:

Coordinate system: 'Y'-up right-handed (the same as Maya).●

Group By: “Material” if using detail textures with backface culling. Otherwise group by “All”.●

Be careful with the “node” and “none” option as they can potentially create thousands of object●

shape nodes on the Maya side.

Enable “Include branch blending”.●

Enable “Transmission to emissive”. This will carry the transmission color over to Maya.●

Enable “Separate alpha textures”. This will create separate image files for opacity, displacement,●

and transmission.

If exporting “camera-facing” leaves, first position the camera in the 'Tree Window' to the correct●

place. The leaves will face only the position of the camera at the time of export.

Avoid:

Wind animation longer than 10 seconds unless it is completely necessary. Wind animation is●

saved as point cache files, which can easily make your 'FBX' exports go from megabytes to
gigabytes.

Only export bones (skeleton) and spines if necessary. These options are better implemented on●

an as-needed basis, since they require the creation of many nodes.

Version History

SpeedTreeFBX 1.02
Added support for using point cache animation in tandem with skeletal rigging.●

Added support for exported spines and spine rings.●

Added “oscillation” by default to point cache nodes, which ping pongs the animation.●

Fixed bug where texture browser slots weren't replacing correctly.●

Removed errant “SpeedTreeSoftwareNormals” node if importing straight to to mental ray●



processing type.
Fixed loading shaders without textures with mental ray.●

Corrected asset placement of displacement nodes.●

Added gamma options to file translator.●

SpeedTreeFBX 1.01
SpeedTree FBX updated for SpeedTree Cinema and Studio v6.1.3.●

Various bugs fixed, including a few minor Python exceptions.●

Carriage return added to “Maya.env” before adding the SpeedTree plug-in path.●

Automatically loads “SpeedTreeSWAImporter.py”.●

SpeedTreeFBX 1.0
SpeedTree FBX plug-in for Maya released with SpeedTree Cinema and Studio v6.1.1.●

Known Issues:

There are occasional issues about using Viewport 2.0. SpeedTree 'FBX' is more stable with●

Viewport 2.0 if “Maya Hardware 2” is the selected process type.

Maya 2011 Only - Using the “Import…” menu item does not work in Maya 2011. As such, the●

option has been disabled in that version. Instead, use the following MEL command to get your
SpeedTree 'FBX' models into the scene: ImportSpeedTreeFbx;

Read our blog >>
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